
Pro Tools. 10.0 
Av Knut Halmrast 

 
BEGREPER: 

 
Session: Et Protools-dokument 
med tilhørende filer og regioner.  
 
Spor: (track): (Stereo og mono). Vi 
bruker vanligvis audiospor og 
master-fader. Et spor tilsvarer en 
kanalstripe i mixervinduet. Et spor 
”låter ikke”. Det gjør derimot en: 
 
Region / clip: En rektangulær 
firkant med bølgeformer (lyd) eller 
MIDI-info som ligger på et spor. 
 
Audio-fil: Et opptak på disken. 
Finnes i finder-mappen ”Audio” 
sammen med Session-filen. Kan 
sees i filoversikten på høyre side 
av edit-vinduet. ( trykk på <-I , 
nederst i høyre hjørne, om den ikke 
synes) 

 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 

 
NYTT DOKUMENT: 

New session; 
 
48 kHz, filmstandard /  
44,1 kHz CD-standard 
16 bit/24 bit 
WAV,   
 

       

 
 
Lagre: Lag mappe, gi prosjektet (session´en) fornuftig navn med en gang og 
lagre på stedet du ønsker på disken, slik at du lett kan finne det i finder. 
Lydfilene (og andre filer) vil automatisk lagre seg i egne mapper sammen med 
prosjektfilen. Pga. Protools måte å jobbe på, er det svært viktig at dette blir 
gjort på en riktig måte allerede fra begynnelsen av prosjektet. 
 
 



EDIT VINDU: 
 
Lage spor, new track: Track-menyen – ”new track” (shift-cmd-N). Antagelig 
vil du trenge både stereo og mono audiospor. Om du også trenger MIDI-spor, 
kan du trykke på +tegnet til høyre og fylle ut ny kolonne.   
 

 
 
Master-track: Bør du også lage. Velg stereo. På mastersporet kan du 
kontrollere total-nivået på signalet som sendes ut av maskinen og evt. justere 
det. ( New track: Velg stereo og master-fader). 
 
Navne spor: Til venstre for sporet 
– Dobbeltklikk på ”Audio 1”.  
 

     
 
Opptak: Plugg inn jacker eller XLR 
i lydkortet. Velg ”line”/mic”. (evt. 
48volts). Sett ønsket spor i 
opptaksmodus ved å klikke på ”R” 
til venstre på sporet. Juster 
inngangsvolumet på lydkortet. 
Opptaket vil bli oppkalt etter sporet. 
(MK: Ha et eget spor som 

innspillingsspor, og skift navn for 
hver ny lyd som spilles inn. Musikk: 
Et spor til hvert instrument).  
 

 
 
Solo: (bare høre det valgte sporet): 
Trykk ”S” på venstre side av sporet 
 
Mute: (stille): Trykk ”M”på venstre 
side av sporet 
 
Forstørre /forminske et spor 
horisontalt: Øverst til venstre, 
piltastene over de små tallene 
”12345”, eller forstørrelsesglass. ( 
Du kan også lagre egne 
skjermbilder: Hold nede cmd og 
knapp 1-5 ). (Dette lille vinduet kan 

være skjult og du finner det ved å 
trykke på en ring med nedover-
trekant øverst på høyre side. Velg 
”Zoom -controls”).  

        

 
Forstørre /forminske et spor 
vertikalt: Dra linjen under 
spornavnet nedover.  
 



Verktøy 
 

 
 
Øverst på Edit-siden, fra venstre:  
Slip/grid: I feltet: ”Shuffle, Spot, Slip, Grid”, velg:  

# Slip for å kunne flytte regionene fritt, 
# Grid hvis du jobber med musikkinnspilling og taktstreker.  

Zoom: Trinnvis zoom: Mac, Ctrl-klikk og dra, PC, Start-klikk og dra 
Trim: [klammeparantes, forkorter eller forlenger regionene].  
Selector: (Markeringsverktøy, markerer et valgt område). 
Grabber: (hånd, markerer en hel region) 
Scrubber: skrubb frem og tilbake i en region for å høre detaljer. 
Pencil: Blyant 
Trippelverktøy: (smart-tool) Tre verktøy ( Trim, Selector, Grabber) som kan 
kobles sammen ved hjelp av det avlange feltet over. Velger man denne 
funksjonen, får man også tilgang til fade og x-fade. 
 
Fade (inn eller ut): Velg 
trippelverktøy – Øverst, ved 
begynnelse eller slutt av region, får 
du frem en liten boks med 
skråstrek inni. Klikk og dra den fra 
starten av ønsket region. Desto 

lenger du drar desto lenger blir 
faden.  
 

 
 
X-fade: Velg trippelverktøy – 
Nederst på sporet mellom  to 
regioner som ligger inn till 
hverandre får du frem en liten boks 
med kryss inni. Hold musetasten 
nede mens du drar  fra slutten av 

det ene segmentet over I starten av 
det neste.  

 
  

 
Spill av fra starten av valgt region: Trykk den lille firkanten under 
håndverktøyet som heter: Link timeline and edit selection. (Markert blå) 
 
Spill av fra markeringen i linjalen, eller spill av fra tidslinja: Trykk den lille 
firkanten under blyantverktøyet: Insertion follows playback. (Markert blå) 
 
Gå til start: Enter 
 
Markére flere regioner (clips): Markér en region med hånden. Hold nede 
shift-knappen og du kan markere en til. 
 
Flytting av regioner (clips): Sideveis: Ta tak med hånden og dra. Om man 
kun skal flytte regionen ørlite grann, må man først ”dra den løs”, for så å flytte 
den tilbake til ønsket sted. Oppover/nedover: To monospor kan flyttes til et 



stereospor og vise versa. (Et monospor kan ikke flyttes til et sterero-spor eller 
omvendt). 
 
Volum-automasjon: Til venstre på 
sporet: Klikk på knappen”wv” eller 
Waveform” under spornavnet. Velg 
volume. Med hånd eller blyant som 
redskap kan du tegne kurver.  

 

  
 
Panorerings-automasjon: ( høyre/venstre kanal) Til venstre på sporet – på 
knappen”wv” eller Waveform” . Velg panorering. Velg blyant. Tegn kurver. 
 
Automasjon av plug-ins:  
a) Åpne opp ønsket plug-in,  
b) Klikk på ”Auto” øverst til høyre, 
 
 
 
 
 
c) På venstre finner du en oversikt 
over de ulike parameterne som det 
går an å automatisere. Marker de 
du ønsker og velg ”Add”.  
 
 
 
 
Du vil nå finne igjen disse 
parameterne i ”Track-view”, der du 
finner  ”Volume”- og ”Pan” 
automajon 

   
 

  
 

 

 
Import av Audiofiler: ”Drag and drop”. Marker fila i finder, og dra den inn i 
PT-dokumentet. Om den ikke er i riktig format, vil PT lage en kopi som er 
spillbar.  
 
Region-liste: På høyre side av 
editsiden: Trykk på ”<-I” nederst i 
høyre hjørne, og listen over alle 
regioner vil komme frem. 
 

      
 
Spor-oversikt: I kolonnen til venstre (Trykk på I-> tegnet nedert i venstre 
hjørne) : Velg hvilket spor som skal vises/skjules ved å klikke på prikken til 
venstre. Om du ønsker at sporet ikke skal klinge, må du mute før du skjuler 
det.  
 
 
 
 



Flytting av spor vertikalt:  
I kolonnen til venstre kan man også skifte rekkefølge på sporene ved å dra 
opp/ ned. 
 
Pluginns på enkeltregioner:  
To måter: Velg: Audiosuite (bl.a. ”Normalize” som hever volumnivået i en 
region, osv). Alle disse funksjonene påvirker kun valgte regioner, erstatter 
original-regionen med en kopi og prosesserer den. (Det du gjør på denne 
måten er således ”ikke reversibelt” og du bør tenke deg om før du gjør det).  
Den andre måten å bruke plug-ins, er reversibel på alle måter, og påvirker 
hele sporet.   Den finner du i: 
 
Navngi en region (clip): 
Dobbeltklikk på regionen (på sporet 
eller i regionlisten på høyre side) 
med hånd-verktøyet. Velg om du 
skal navne bare regionen, eller 
også filen på disk´en. 
 

 
 
Lime sammen to regioner (clips):  
Editmenyen - Consolidate Selection. (Shift –Alt –3) 
 
Capture region (clip):  
Marker et område, trykk Eple – R, og området legger seg i biblioteket på 
høyre side som en ny region. 
 
Timestretch;  
Trykk og hold på klamme-vektøy - 
knappen. Velg ”Time-stretch”-
funksjonen (en klamme med klokke 
på): Den Strekker innholdet i 
regionen i tid uten å forandre 
tonehøyde).  

 
 
 

 

 
Fjern uønsket automasjon: 
Istedenfor å klikke på alle punktene du har lagt inn: Velg markeringsverktøyet, 
marker ønsket område og trykk backspace. (Du må være i en modus hvor du 
ser kurvene du ønsker å fjerne). 
 

I MENYENE: 
 
Velge tidangivelse over sporene: (taktstreker, minutter og sek, osv):  
Enten: View: > Ruler > Marker det som skal vises. Eller: View > Main counter 
> velg. 
 
Skjermbildet følger songposition-streken: Options > Edit window scrolling> 
page  



MIDI 
 
Opprette et MIDI-spor: Lag et 
instrumentspor (Shift – Cmd - N)  
 
 
Under Inserts i mixeren kan du 
legge inn ønsket instrument.  
 
Spill inn med keyboard, eller klikk 
inn noter med blyanten. Her ser du 
øverst et Instrumentspor uten 
innhold. Under ser du et spor hvor 
det er spilt inn noen toner. Ønsker 
du å redigere tonene, kan du 
dobbeltklikke på feltet, og 
innspillingen dukker opp i en 
pianorull, hvor du kan editere 
tonene.  

 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



MIX VINDU 
 
Plug-ins på spor: (Dvs. effekter, 
f.eks. reverb/romklang, kompressor 
og equalizer). De små pilhodene 
øverst på hver kanal-stripe: Åpner 
forskjellige plug-ins, som påvirker 
hele sporet.  
 

Plug-ins via eff. sends: Sette opp 
en egen effektkanal med for 
eksempel reverb: 

 

1) Klikk-hold på et ”send-felt” på en 
mixer-kanal.  
 
2) Velg ”new track” nederst i 
vinduet som dukker opp.  
 

1)    2)  
 

3) Velg Stereo og AUXinput. 
Navngi kanalen om ønskelig. Trykk 
Create.  
 

3)  

 
 
4 og 5) På den nye AUX – kanalen 
legger dere inn ønsket plugg. 
Juster hvor mye som skal sendes 
til effektkanalen med faderen.  
 
 
Om du ønsker å sende signal fra 
flere kanaler til denne AUX´en: 
Klikk-hold et send-felt på ønsket 
kanal. Velg Track og ønket 
effektkanal. 
 4)   5)  

 
 
 

 
 

Inn og utganger: På stripene 
under plug-ins-ene kan du velge 
innganger og utganger av Protools.   
 

 

 
Pan: Litt under midten på hver kanalstripe. Har du lagt inn pan-automasjon på 
sporet, vil det overstyre hvordan du setter innstillingene her. 
 



Volumfader: Nederst på kanalstripene. (Overstyres av evt. volumautomasjon 
på sporet). Grei arbeidsmetode: Sett først ca-volum på hver enkelt kanal. 
Tegn volumkurver og panorering direkte på sporene i edit-vinduet senere i 
prosjektet.  
 
 
Sidechain-compressor: Å la 
signalet fra et spor styre 
kompresjonen på et annet spor.  
 
a) Hent inn en kompressor. Sett 
Sidechain til ”Key-input”.  
 
 
 
 
 
b) Velg hvor du skal hente styre-
signalet fra ved f.eks. å velge ”Bus 
1”.  
 
 
 
 
 
 
c) Send kontroll-sporet (f.eks. bas-
dr.) til Bus 1. Sett fader til fullt 
volume og gjerne Pre-fader.  

   
 

   
 

 
 
 

 
TRANSPORTVINDU 

 
Hente frem transportvinduet: Window > Transport.  
Hvilke elementer transportvinduet skal vise: View > Transport > velg 
 
 
 
 
 
 
 
 
 
 
 



MIDI 
 
Lage et MIDI-spor: Track-meny: 
New track, Stereo, MIDI-
instrument, Create. 
 
 
 
 
 
 
Lage kanal med MIDI-instrument: 
Mixervindu, Insert A-E, Instrument, 
velg instrument.  
 
 
 
 
 
 
 
 
 
 
Spill på keyboard´et mens du tar 
opp. 
 

 
 
 
 

 
 
 

 
 
Rediger innspilling:  
Bruk de ulike verktøyene for å 
markere og flytte toner. Du kan 
markere flere toner på en gang.  
  
 
Quantize: Rytmisk korreksjon av 
innspilte toner.   
 
 
Flytt tonene rytmisk trinnvis: 
Gridmode 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
Velocity: Har med anslag å gjøre.  
Betyr egentlig hvor fort tangenten 
blir trykket ned. (Man skulle 
kanskje tro at det handler om hvor 
hardt den blir trykket ned, men den 
gang ei). Skala fra 0 – 127 hvor 0 
er veldig ”sakte (og mykt) mens 
127 er et ”fort” (hardt anslag). Dra i 
de røde merkene på toppen av 
stavene for å justere anslaget på 
hver tone.  
 
Tegn velocity med blyanten: Velg 
”Clips view” og blyant.  
 
 
 
 
 
 

 
 
 

 
 

 
 

 

 
 

 
 
 

 
Høre markerte toner: Play MIDI-
notes when editing.   
 
 
 
Loop et clip: Klikk-hold på 
Trimverktøy (klammeparantes).  
Dra i clip´et i øverste halvdel og 
loop det så langt du vil.  
 
 

 
 
 

 

 

 

 

 

 
 

 
 

 
 

 
 

 
 



BOUNCE 
 
Lag en stereomix av arbeidet: 
File-meny > bounce , velg 44,1/48 
khz,  stereo interleaved/split stereo, 
velg navn på filen og hvor den skal  
plasseres på disc´en. 
 

 
 
 
Forminsk kanalstripene i mixevindu : View> Narrow mix (Alt- eple- M)   
 
Kopiere plug-ins fra en kanal til en annen: Trykk-hold ”alt” – dra et plugin fra 
en kanal til en annen. 
 
Om faderposisjonen skal påvirker nivået på meteret på kanalen (Post-
fader): For å se hvordan nivåene på signalene på meteret oppfører seg etter 
at man har flyttet på faderen (eller laget volumkurver): Hengemeny - ”Option” - 
Pre-fadermetering. Slik det står opprinnelig er at man ser nivået på signalet 
uavhengig av fader-plasseringen.  
 
 

AUDIO SUITE: 

 
Heve altfor svake nivåer i en region (clip): Under Audiosuite-menyen - 
Other:  
 
”Normalize”: vil heve nivået til 
max, før det vrenger.  
 

 
 
”Change gain”: Her har man mulighet til manuelt å stille inn hvor mye man 
ønsker å heve/senke 
 
 
 
 
 
 
 



EKSTRA: 
 
Om maskinen ikke greier å spille av, men kommer med en ”buffer-size”-
melding og stopper: Setup > Playback engine: Øk H/W Buffersize, DAE 
playbackbuffer, og Cache size. 
 
Importere OMF (f.eks. fra final cut, ikke vg1-pensum): 
File – import – sessiondata - finn ønsket omf-fil. Når du åpner (pakker ut) filen, 
sørg for at du lager en kopi av filene i mappen til prosjektet ditt.  
 
Import av video: File>Import> Video. (Ikke vg1-pensum) 

Automasjon av pluginn-parametere i Edit-vinduet.(Som hyperdraw av 
volumautomasjon).  
Hent frem ønsket plug-in på kanalstripen på mixeren. 
Trykk ”auto”. Velg ønsket parameter som skal dukke opp på venstre-siden i 
edit-vindu. Trykk add>> og OK. Trykk – hold på ”waveform” til venstre på 
sporet på edit-siden og man finner automasjons-parameteret.  
 
Navning av flere spor samtidig: Hold nede ”alt” og man kan skifte navn på 
flere spor uten å gå ut av vinduet. 
 
Hoppe frem eller tilbake i et markert område: piltastene 
 
Forandre start og sluttpunkt på et markert område: hold ”shift” nede og 
dra i kantene 
 
Zoom toggle-knapp: 
Under forstørrelsesglasset finnes en knapp som forstørrer spor m. markerte 
regioner. 
 
Sette opp grupper: Controll G: (Gruppen ”all” vil alltid være der). 
 
Koble regioner i gruppe: 
Markér regioner, Under ”region” 
finner du ”Group” (Alt-Eple-G”) og 
andre nødvendige funksjoner. En 
oversikt over disse gruppene finnes 
nederst til høyre på region-listen. 
 
 
Templates: Ferdige oppsett / 
maler. Man kan lage (og lagre) 
egne templates. Finnes under File-
menyen. 
 
 
 
 
 
 
 

 
 

9.0 
TASTEKOMMANDOER 

 
Denne lista er for Mac. Om du har 
PC: Bytt ut Cmd (eple) med Ctrl.  
 

GENERELLE FUNKSJONER 
 
Cmd > S:   Save 
Cmd > C:   Copy 
Cmd > V:   Paste 
Cmd > Z:  Undo 
 

TRANSPORT 
 
Spacebar:   Start/ stopp 



Enter:    Tilbake til start 
Alt > Enter:   Gå til slutt 
Piler:   Hopp til start 

eller slutt i et markert 
område 

Ctrl >Tab:     Markér neste 
region 

Ctrl>Alt>Tab: Markér forrige region 
Tab:  Markør til neste 

sync-p. 
Alt>Tab:  Markør forrige 

sync-p. 
Shift > space:  Avspilling i halv 

fart 
 

SPOR OG FILER 
 
Shift > Cmd > N:  Nytt spor 
Shift > alt > D:  Dupliser spor 
Shift > Cmd > I:  Importer audio til 
bibliotek på høyre side. 
Alt > Cmd > B:  Bounce to disk 
Trippel-klikk m. markør: Velg hele 
sporet 
Ctrl > pil:  
 Forstørrer/minsker spor 
Ctrl > E:  Hurtigforstørrer 
et spor 
 

REDIGERING 
 
Cmd > A:   Select all 
Cmd > B:   Clear 
Cmd > E:   ”Separat region” 

(klippe ut en del av en 
region) 

Cmd > M:   Mute region 
Cmd > X:   Fjern markert 
område 
Shift >Alt >3:  Lime sammen regioner 
 
Alt > R:  Loop record 
Shift>Cmd>L: Loop playback 
Cmd > N:  Startpunkt følger 

tidslinja eller ikke.  
 
 
 
 

VIEW 
 

Ctrl > R /T:   Zoom inn eller ut 
Cmd > 1-5:  Save zoom-
preset 
Hold nede knapp 1-5: Save zoom-

preset 
Ctrl > E:   Zoom inn og ut 

på et spor 
 
 
Alt > F (Alt > klikk på forst-glass): 
Fyll skjermen med markert område 
Alt > A, (Dobbeltklikk på forst-
glass): Hele session fyller skjermen 
 
 

VERKTØY 
 
Cmd > 1: 

 Forstørrelsesgla
ss 

Cmd > 2:  Trim 
Cmd > 3:  Markeringsverkt. 
Cmd > 4:  Hånd 
Cmd > 5:  Høyttaler 
Cmd > 6:  Penn 
Cmd > 7:  Trippelverktøy 
 
Ctrl > G:   Lag gruppe 
  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

 
Protools - youtube 

 
INTRODUKSJON: 
 
Velkommen - introduksjon: 
http://www.youtube.com/watch?v=v
gDhKt-ePak 
 
Ny session: 
http://www.youtube.com/watch?v=
SVDeC1PGq28 
Inn og utganger: 
http://www.youtube.com/watch?v=x
OvWLIG0dvo 
 
Setting up a music record-
session 1: 
http://www.youtube.com/watch?v=
QU4rhBNlnHw 
 
Setting up a music record-
session 2: 
http://www.youtube.com/watch?v=l
VqmuTK5_E0 
 
Ny session, Bit og samplerate: 
http://www.youtube.com/watch?v=
SVDeC1PGq28 
 
Menyoversikt: 
http://www.youtube.com/watch?v=
XGq6ETj_IXk 
 
Midi/komponering: 
http://www.youtube.com/watch?v=7
hg15gQTgbo 
Midi eventlist: 
http://www.youtube.com/watch?v=
DjtdzPQN8ow 
 
 
OPPTAK/IMPORT: 
 
Klargjøre en session for opptak: 

http://www.youtube.com/watch?v=
HS4nKFKb1dY 
 
Ny session og Clicktrack: 
http://www.youtube.com/watch?v=z
1lUp5bim8U 
 
Mikrofonoppsett: 
http://www.youtube.com/watch?v=
mFG5ZE457ok 
 
Opptak/nivåsetting: 
http://www.youtube.com/watch?v=
HS4nKFKb1dY  
 
Importering av lydfiler: 
http://www.youtube.com/watch?v=v
FUqqNUx_90 
 
 
MIDI: 
 
http://www.youtube.com/watch?v=h
-BxTrJ1f_w 
 
http://www.youtube.com/watch?v=J
i3C__hf0qY 
 
http://www.youtube.com/watch?v=u
KLg2MAD34I 
 
 
REDIGERING: 
 
Oversikt redigering og mix-
siden: 
http://www.youtube.com/watch?v=Z
0v8P7L1hNQ 
 
Redigeringssiden: 
http://www.youtube.com/watch?v=
Gw51ocWJBUU 
 
Smart-tool (trippelverktøy): 
http://www.youtube.com/watch?v=c
0y9n5CTR1I 
 
Zoom: 



http://www.youtube.com/watch?v=9
Sdrv1u78ag 
 
Plugins: Reverb AUX: 
http://www.youtube.com/watch?v=r
6vqnA3j5Gc 
 
Plugins, EQ: 
http://www.youtube.com/watch?v=4
R4WvfclTrg 
 
Volumautomasjon: 
http://www.youtube.com/watch?v=
YcULyOQ3nRM 
 
Hvordan legge inn en aux med 
plugin: 
http://www.youtube.com/watch?v=
OK050SHpIbE 
 
Oppsett av romklang via AUX: 
http://www.youtube.com/watch?v=r
3K33qXYz4g 
 
Lydredigering: 
http://www.youtube.com/watch?v=5
LmVwMEqfIE 
 
Trommeredigering: 
http://www.youtube.com/watch?v=q
V70ggNn1hM 
 
 
MIX / EKSPORTERING: 
 
Mixe vokal i Protools: 
http://www.youtube.com/watch?v=o
rZUiPbl1JY 
 
Trommemix: 
http://www.youtube.com/watch?v=
ROp61osrySo 
 
Mix av Filmlyd m. dialog: 
http://www.youtube.com/watch?v=
Ypbu-yVGlog 
 
Mix i forskjellige høyttalere: 

http://www.youtube.com/watch?v=l
dysYkF8DF8 
 
Exportere audio fra Final cut: 
http://www.youtube.com/watch?v=4
kzqhl2qKQc 
 
Video: 
http://www.youtube.com/watch?v=p
ej_KoyO8MY 
 
Audiofil til Final Cut: 
http://www.youtube.com/watch?v=p
2IhO_wtItc 
 
Bounce to disc: 
http://www.youtube.com/watch?v=h
8XDXnll7ME 
 
 
AVANSERT: 
 
Beat Detective og groove 
templates: 
http://www.youtube.com/watch?v=f
Hgm_p4u-CI 
 
Ferdigmix, alternativ til bounce: 
http://www.youtube.com/watch?v=
KYAWSKrua_c 
 
Avansert mixing: 
http://www.youtube.com/watch?v=_
VRr7Ft1-PU 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Multi-timbralt oppsett, med 
Kontakt 5: ”N.I. Kontakt 5" er ikke 
en integrert del av Pro tools. Den 
kan imidlertid spille av flere lyder 
samtidig på hver sin MIDI-kanal:  
 
Opprett noen Instrumentspor (Shift-
Cmd-N).  

Klikk-hold på dette feltet:  og 
velg hva som skal vises: 
INSTRUMENT, INSERTS og I/O.  
 

 

 
Under INSERTS vil du kunne åpne 
Kontakt 5. Gjør det på det øverste 
sporet. Last så inn flere enn ett  
instrument i selve sampleren (se 
Kontakt 5 - manual). De vil gjøre 
bruk av ulike MIDI-kanaler.    

I kolonnen INSTRUMENT står det 
”Kontakt 5 1-1. 
Her velger du MIDI-kanal. Gjør det 
på de ønskede kanalene under.  

 

I Kontakt, klikk på Output:         
 
 
Nederst i vinduet finner du 
kanalene. 
   

 
 

Klikk på Add channels   
     

 
 
 
Velg hvor mange utgangskanaler 
du ønsker å lage. 



 
 
 
Nederst på hver kanal kan du 
bestemme utganger. Velg aux + nr.  
 

 

 
Re-start Protools for å få oppsettet til å bli aktivert.  
 
 
Velg utganger for de ulike 
instrumentene i Kontakt 

 
 

Under INPUT på mixeren i 
Protools, velg Plug-in > Kontakt > 
aux + nr. 

 
 


